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You must install the software bundled on the Canon
Digital Camera Solution Disk before connecting the
camera to the computer.

@ Install the software.
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Macintosh
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Connect the camera
to the computer.
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¢ This guide explains how to install the software programs and
briefly introduces their functions and operating procedures.

You may be able to download images without installing the
software programs if you use certain operating system
software (p. 82). (Excludes Windows 2000)
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SAFETY PRECAUTIONS

The precautions noted within this guide are intended to instruct you in the safe and correct use of
the products and to prevent injuries or damage to yourself, other persons and property. Please
read and ensure that you understand them before proceeding to other sections of the guide.

AWarnings This symbol indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

AWarnings

¢ Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-
ROM:s. Playing the CD-ROM(s) in an audio CD player (music player) could damage the
speakers. It is also possible to suffer from hearing loss from listening with headphones to
the loud sounds of a CD-ROM played on a music CD player.

Disclaimer

e While every effort has been made to ensure that the information contained in this guide is
accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

* No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior
written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the memory cards,
personal computers, peripheral devices, or use of non-Canon memory cards.

Trademark Acknowledgments

e Windows, Windows Vista and the Windows Vista logo are trademarks of Microsoft Corporation,
registered in the U.S. and other countries.

* Macintosh, the Mac logo, Quicktime and the Quicktime logo are trademarks of Apple Computer
Inc., registered in the U.S. and other countries.

Canon Customer Support

For Canon Customer Support contacts, please see the customer support list supplied with your
camera.

Copyright © 2007 Canon Inc. All rights reserved.
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Using the PDF Manuals

The following PDF-format manuals (hereafter PDF manuals) are provided to
explain the features and procedures for using ZoomBrowser EX and
ImageBrowser.

e ZoomBrowser EX Software User Guide (Windows)

* ImageBrowser Software User Guide (Macintosh)

aforementioned PDF
ot already installed on
e following website.

Viewing PDF Manuals

Viewing Manuals Downloaded from a Website

These PDF-format manuals are available on the Canon website. Use your
browser program to download these manuals from the following URL:
http://web.canon.jp/Imaging/information-e.html




This chapter explains what you can accomplish using the camera with the software contained
on the Canon Digital Camera Solution Disk.
It also lists the computer system configurations required to use the software.

About this Guide
® The explanations in this guide are based on Windows XP and Mac OS X v10.3. If you are
using another version of these operating systems, the actual screen contents and
procedures may vary slightly from those shown.
e The following terms are used in this guide.
Mac OS X is used for Mac OS X (v10.3-v10.4)
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It's so Simple! Make Prints Right at Home
Like a Pro

Shoot the images

See your Camera User Guide for shooting instructions.

Install the software on the
computer

Windows (p. 11)
Macintosh (p. 44)

Just install the software once at the beginning.



Connect the camera to the computer

\\\\\\\
\\\\\\\\\

Windows (p. 16)
Macintosh (p. 46)

Download images to the computer

Precautions for
Connecting the
Camera to the
Computer (p. 10)

I connecting instructions.

Windows (p. 21)
Macintosh (p. 50)
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Unbounded Possibilities with Entertaining
Software

Print a Variety of Layouts

Print with the diverse layouts available in ZoomBrowser EX (Windows) and ImageBrowser
(Macintosh). The examples shown are from ZoomBrowser EX (Windows).

With One Photo per Page Print, Confirm all your images in one glance
printing images is also easy. with index (contact sheet) printing.

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch.




Send an Image as an E-mail Attachment

Attach an image to an e-mail message by starting your mail software from within
ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

Operate the Camera Shutter from the Computer (Remote Shooting)

You can use ZoomBrowser EX (Windows) or ImageBrowser (Macintosh) to operate the camera
shutter from the computer to shoot images (Remote Shooting). The recorded images are
downloaded directly to the computer.

The shutter is operated from the computer.

Edit a Movie

You can edit movies, linking movies and stills that have been downloaded to the computer,
adding text, such as titles, adding background music or applying various special effects.

Extract Stills from Movies

You can extract a still from the displayed movie and save it as a new image file. You can also
specify a range of frames and extract multiple stills.
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System Requirements

Please install the software on a computer meeting the following minimum requirements.

0sS

Windows 2000 Service Pack 4
Windows XP (including Service Pack 1 and Service Pack 2)
Windows Vista

Computer Model

The above OS should be pre-installed on computers with built-in USB
ports.

CPU Windows 2000/Windows XP: Pentium 500 MHz or higher
Windows Vista: Pentium 1.3 GHz or higher
RAM Windows 2000/Windows XP: 256 MB or more
Windows Vista: 512 MB or more
Interface USB

Free Hard Disk
Space

e Canon Utilities
- ZoomBrowser EX:
- PhotoStitch:
e Canon Camera TWAIN Driver:

200 MB or more
40 MB or more
25 MB or more

Display

1,024 x 768 pixels/High Color (16 bit) or better

oS

Mac OS X (v10.3-v10.4)

Computer Model

The above OS should be pre-installed on computers with built-in USB
ports.

CPU PowerPC G3/G4/G5 or Intel Processor
RAM 256 MB or more
Interface USB

Free Hard Disk
Space

e Canon Utilities
- ImageBrowser:
- PhotoStitch:

200 MB or more
40 MB or more

Display

1,024 x 768 pixels/32,000 Colors or better




guaranteed.

¢ A sound card is required to play movie file audio tracks under Windows.
e \With Windows, QuickTime is required to save images merged with
PhotoStitch as QuickTime VR images. It is also required to play and edit

e A CD-ROM drive is required to install the software.
e Even when system requirements are met, not all computer functions can be

movies on the Windows 2000 platform.

* Macintosh software cannot be used on disks formatted in the UFS (Unix File

System) format.

Programs and Compatible Operating Systems

The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all models. It
contains the following programs.

Windows Programs

Compatible OS | Windows Wmdgws WindO\ivs Maior Eunctions
Program 2000 XP*2 | Vista™? J
Downloading, displaying,
ZoomBrowser EX o o @ |organizing and editing
iImages
. Driver for Canon brand cameras
s Merging images to make
1
PhotoStitch @ () ) panoramas
.. |Pownloading images and
EOS Utility o () —"3 | other functions for EOS

DIGITAL series cameras

*1 Can be started from within ZoomBrowser EX.
*2 Installation of the driver is not required.

*3 Images are downloaded using ZoomBrowser EX.

Macintosh Programs

Compatible 05 Mac OS X Major Functions
Program
ImageBrowser ® Downloading, displaying, organizing and editing images
PhotoStitch*1 () Merging images to make panoramas
. Downloading images and other functions
EOS Utility ® for EOS DIGITAL series cameras

*1 Can be started from within ImageBrowser.
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Before You Connect the Camera to the Computer

Ensure that you have installed the software from the supplied Canon Digital
Camera Solution Disk before you connect the camera to the computer.

Precautions for Connecting the Camera to the Computer

® The connection may not operate correctly if you attach the camera to the computer with an
interface cable via a USB hub.

e The connection may not operate correctly if you are using other USB devices, excluding USB
mice or keyboards, at the same time as the camera. If this occurs, disconnect the other
devices from the computer and try reconnecting the camera.

* Do not connect two or more cameras at the same time to the same computer. The
connections may not operate correctly.

e Never allow the computer to go into standby (sleep) mode while a camera is connected via
the USB interface cable. If it does happen, never disconnect the interface cable. Try to awaken
the computer with the camera in the connected state. Some computers will not awaken
properly if you disconnect the camera while they are in standby (sleep) mode. Please refer to
your computer manual for instructions regarding the standby (sleep) mode.

® You are recommended to power the camera from a household power source
(AC adapter) when connecting to a computer. Ensure that you use fully
charged batteries if you will not be using a household power source.

*See the Camera User Guide for procedures connecting the camera to the
computer.




This chapter explains the basic procedures for installing the software and connecting the
camera to a computer. Read this material before you connect the camera to the computer.

Installing the Software and USB Driver

Start by installing the software from the Canon Digital Camera Solution Disk.

0 ® You must install the software before you connect the camera to the
computer.

* You must have authorization as a Computer Administrator to inst
programs.

ltems to Prepare

e Your camera and computer
e Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

T  Confirm that the camera is NOT connected to
the computer.
If it is, disconnect the cable. The software cannot
be properly installed if the camera is connected to
the computer at the start.

2 Close any programs that are running.



]2 Using the Software on the Windows Platform — Preparations

3 Place the Canon Digital Camera Solution Disk in the
computer’'s CD-ROM drive.

If the [User Account Control] window appears, follow the
on-screen instructions to proceed.

If the installer panel does not appear automatically, use the
following procedures.

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not appear
automatically.

Windows Vista
1. Select [Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].
f iy, 3
3. Double-click the [SETUPEXE]* " icon.
4. When [User Account Control] window displays, follow the on-screen instructions to
proceed.

Windows XP

1. Select [My Computer] from the [Start] menu.

2. Right-click the CD-ROM icon and select [Open].
N

3. Double-click the [SETUP.EXE]* Ku icon.

Windows 2000
1. Double-click the [My Computer] icon on the desktop.
2. Right-click the CD-ROM icon and select [Open].

>
3. Double-click the [SETUPEXE]* ‘& icon.

* Some computers may not display the [.EXE] file name extension as shown above.

4 Click the Digital Camera Software [Easy
Installation] button. Canon DIGITAL CAMERA
To individually select the software to install, __ Solution Disk
click [Custom Installation]. : /

\/ Easy Installation ::

SR —
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5 If other software is running, close each
program before clicking [OK].

Start instaling Digital Carnera Solution Disk.
Close any other open applications and click [OK].

© Review the installation settings and
click [Install]. [ contrmaton

step2  License

sp 3 Installation

suepd  Finish
The items displayed here differ according to -
the software installed. Vs Gt ol by o v o o 1 1
Installation folder Available space: 3489 MB
Ci\Program FiesiCanont,
Click [Install] to start nstaling.

7 Click [Yes] if you agree to all of the -
terms of the software license AR Hoamed oot o
agreement. O i =
lip s _ CANON SOFTWARE LICENSE ACREEMENT -
The installation will start. we3 s T
sipd  Finich ﬁnm.!mmmmum::ggﬁw
FROMPTLY STOR THE ISTALLATION FROCESS. N
Follow the on-screen instructions to Lomwosne
proceed with the installation. e e
gm&':w. 3 :
M‘“ o Conen
R ¢
L
v : ;
(= )
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8 When the installation is over, select
[Restart computer immediately

(Recommended)] and C|iCk [ReStart]- Installation of the software has been completed.
At this stage, do NOT remove the Solution Y e
Disk from the CD-ROM drive yet. - =

[ . Finish |\\_ Restart _/}I

If there is no need to restart the computer, the [Finish] screen will display. Click [Finish],
remove the Solution Disk from the CD-ROM drive and proceed to Step 10.

Q Remove the disk from the CD-ROM drive when your
normal desktop screen appears after restarting.

This concludes the software installation.

Continue by connecting the camera to the computer so
that the USB driver can be utilized.

If you install

WD

|§| See Uninstalling the Software (p. 72) to delete the installed programs.

10 Attach the camera to the computer with the
interface cable and set the camera to the
correct mode for connecting.

Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.
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If the Digital Signature Not Found window (e x|
appears, click [Yes].

The Miciozoft digital signature affirms that software has
been tested with “Windows and that the software has not
been altered since it was tested.

The software pou are about to install does not contain a
Microzoft digital signature. Therefare, there is no
guarantee that this software works comectly with
Windows.

HEHHHHRHHHRE

If pow want ta search for Microzoft digitally signed
zoftware, vizit the ‘Windows Update \Web site at
http: ¢ Awindowsupdate. microzoft. com to see if one iz
available.

Do you want to continue the installation’?

——
es 3 Mo | Mare Info |

The USB driver will automatically finish installing onto the computer when you attach the
camera and open a connection.

Dialogs similar to the following will appear during this process (first time the camera is
connected to a computer only).

Windows Vista
The dialog on the right will appear after a
few moments.

F@ Canon

Device driver software installed successfully,

Windows XP

The dialog on the right will appear after a

few moments. ﬂ
i) Found New Hardware |*
Zanon Digital Camera

Windows 2000

Restart the computer according to the instructions if you are prompted to do so by a

message.

A dialog allowing you to set the default settings will display after installation. See Using
the Software on the Windows Platform — The Basics (p. 16) for the subsequent
procedures.

e |f you experience problems installing the USB Driver, first uninstall it
(p. 77) and then reinstall it. (Windows 2000)
e See Uninstalling the USB Driver (p. 73) to delete the USB driver installed
with these procedures. (Windows 2000)
e See If You Were Using ZoomBrowser EX Version 2 or 3 (p. 81) if you
were previously using either version.

This concludes the software and USB driver installation and the procedures for connecting the
camera to the computer.
You may now download camera images to the computer (p. 16).



This chapter explains the procedures for using ZoomBrowser EX to download the camera's
images to the computer and print them.

Read this chapter after completing the preparations in the Using the Software on the Windows
Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different according to whether you are using a camera to computer connection (see below) or
a memory card reader (p. 19).

amera is connected t
oximately 1000) on t
that case.

1 Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

You may not be able to download imagesv
computer if there are a large number :
memory card. Use a memory card

Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See the
Camera User Guide.

The Camera Control Window will appear.

Acquire Images | Frirt " Set to Camera " Femate shooting]

Downloads using camera

Camera Control Window

Starts to download images

Lets you select and download images




First Time Camera is Connected to a Computer
Set the following settings the first time you connect the camera to the computer. These
procedures are not required from the second connection onward.

Select [Canon CameraWindow] when a
dialog (Events dialog) similar to that on Canon XXXXXX XXKNNNNKN
the right displays and click [OK].

Camera connected

Your camera model name or [Canon

Camera] will appear here. Select the program to launch for thiz action:
Different programs may display
according to your computer setup.
9 y P P ""\I—_.I._ Canon EOS Utility
B Downloads images from EOS camera
7= Microzoft Scanner and Camera wizard

Download pictures from a camera or scanner

[ Always use thiz program for thiz action

= Do

0 If this Events dialog does no i he [Start] menu and select

[CameraWindow], [P
[CameraWindow

Download the images.

Download the images using the camera or
the computer.

By default, the downloaded images are el b
saved into the [Pictures] or [My Pictures]
folder.

Acquire Images | Print || Set to Camera || Remate shooting|

Press the camera's button

Downloads uzing computer

%@ Starts to download images

Lets you select and download images

Placing a check mark here causes this
window to automatically open when the
camera and computer are connected.

[#] Displays this screen when the camera is connected

You can adjust the settings, such as the type — references. |

of image downloaded and the destination
folder, by clicking [Preferences].

17
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Using the Camera to Download Images (Direct Transfer Function)

¢ |f the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear in the LCD monitor. In addition, the
Lhar (Print/Share) button will light if your camera is equipped with one.

e See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the
camera and press the Lhas (Print/Share) s ~N
button or the FUNC./SET button.

Direct Transfer

[Ga ALl Images..
i New Images..
[v= DPOF Trans. Images..
= Select & Transfer..
Wal lpaper .

Using the Computer to Download Images
CIICk [Starts to download imageS]. & CameraWindow - Canon XXC00GO00K

Acquire Images | Print || Set to Camera || Remaote shooting|

Diownloads uzing camera

@QN Fress the camera's button

Downloads using computer

- l
ol
%l Starts to download images

Lets you select and download images

Dizplayz thiz zcreen when the camera is connected

¢ By default, all the images that have yet to be downloaded will download
to the [Pictures] or [My Pictures] folder.

*To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

e Click [Lets you select and download images] to show the camera images
in a list, check the images before downloading and download only

selected images.
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The dOWﬂloaded |mages are Saved |nto ZnnnBrwser EX - C:\Documents and Settingsboody DocumentsWy Picturesi2005_09_09
folders according to the shooting date. = 8| @ [ e G o @ ) o
At the same time, they will also appear g— i s A A RAPED
grouped by date in the [Last Acquired @{

Images] at the top of the Folder Area. @“‘t

[Last Acquired Images] [% ‘p :

The last downloaded images will display according

to their shooting dates.

IMG_D001.0PG IMG_0001_1.0PG IMG_0002.0PG

— ]

= all Images
& &4 shooting Date

¥ zo05_09_10

* {8 2005_09_11

Destination for the downloaded images
The downloaded symbol displays on
downloaded folders.

IMG_0004.1PG IMG_0005.IPG

Favorite Folders

IMG_0006.0PG

=]
D=
3 2005_09_11
) 200s_09_12
{53 zo05_10_02
%) 2006_09_09

® (Em

Folder area

Thumbnail
According to the default settings, the thumbnails (tiny versions) of the downloaded images
display in the Main Window when the downloading is complete.

Next, print out the images (p. 21).

Memory Card Reader Connection

T insert the memory card into the reader.

Use a separately sold card adapter if required.
See the manual for the memory card reader for its connection and handling instructions.

2 Sselect [View/Download Images using
Canon CameraWindow] when the

CANON_DC H:)

dia |og to the r|g ht a ppears a nd click Wwindaws can perfarm the zame action each time you insert
a dizk or connect a device with this kind of file:
[OK]. .
) . ) |&] Pictures
The Camera Control Window will display. \hat do you want Windows to do?
'.;‘:é using Photo Printing YWizard A__

L Wiew a glideshow of the images
= uzing Windows Picture and Fas Wiewer

_%29 Copy pictures to a folder on my computer
uzing Microzoft Scanner and Camera Wizard

Wiew lmages
Lzing ZoomBrowser B

| £

[ J&hways do the selected

Ok Cancel

If the dialog above fails to appear, click the [Start] menu and select [All
Programs] or [Programs], followed by [Canon Utilities], [CameraWindow],
[CameraWindowMC(] and [CameraWindow], and proceed to Step 3.
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3 Click [Starts to download images]. Ep———

Acquire Images | Print || Set to Memory Card |

g Starts to download images

o e Lets you select and download images

You can adjust the settings, such as the type —

of image downloaded and the destination _

folder, by clicking [Preferences].

e By default, all the images that have yet to be downloaded will
download to the [Pictures] or [My Pictures] folder.

e To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

e Click [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.

*See Memory Card Folder Structure (p. 75) for information about
memory card folder structures and file names.

The downloaded images are saved into folders according to the shooting date.

At the same time, they will also appear grouped by date in the [Last Acquired Images] at
the top of the Folder Area.

Next, print out the images (p. 21).
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Printing Images

There are two ways in which images may be printed: One Photo per Page Print and Index Print.
This section explains the One Photo per Page Print method.

* Movies cannot be printed, but with Windows Vista and Windows XP you can
print stills after they have been extracted from movies and saved to files.

¢ To use the Index Print option, click [Print] in the Main Window, followed by
[Index Print].

One Photo per Page Print

This option prints one image per page in a standard "photo" format. If you select multiple
images, it will print them on the corresponding number of pages.

1 cick [Print] in ZoomBrowser EX's Main Window, followed by [One Photo Per Page
Print].

7 ZoomBrowser EX - D:\Documents and SettingsboodMy DocumentsiMy Picturesi2005_(0
Fle Edit Wiew Tools Intermst Help

7 ZoomBrowser EX - C:\Documents and SettingsboodMy DocumentsiMy Picturesi2005_(
Fle Edit Wiew Tools Intermet Help

[ Tasks 6] BB e mege (EE] Fropereies @Slide Shaw § [ Taske e = it |3 Provsiies @shde Show [
‘@ S — ‘ ZoomMods | Seroll Mode | Previewbode| - I Zoom Mode | Scroll Mode | Freview Mode|

200509 09 € t H-0-|[x]A 2050908 € 4 H-0-|[]
‘ ra" View & Chassify ‘ @ View & Classity

[@ Edit @ Edit
'—1 @ Export
==
Index Print
<
[ Print Using Other Software l IMG_0001 375 [MG_0002.3F
EnsraeEnes
e |f you have installed the Easy- —o—
= File View Help
PhotoPrint program that
o ¥ “toP Click the [Camect/Enhance] button ta conect or enhance images.
accompanied a Canon-brand - e e e e Sl

printer, you will proceed to the
Easy-PhotoPrint printing window
shown at the right when you
select [One Photo per Page Print]
according to the default settings.
If a window similar to it opens,
read the Help menu for Easy-
PhotoPrint for instructions to proceed.

¢ To proceed to the ZoomBrowser EX printing window as shown in Step 2
when you select [One Photo per Page Print], click the [Tools] menu and
select [Preferences], followed by the [Printing] tab. Select [Use the Print
Function in ZoomBrowser EX].

Conect/
Erhance
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2

After confirming that [1. Select Images] is selected, select images.

You can select multiple images by holding the [Ctrl]] down while clicking on successive
images.

7' ZoomBrowser EX - C:\Documents and SettingsboodMy DocumentsiMy Picturesi2005_09_09
Fle Edt View Tools Internet Help

o+
N2 IndexPrint

Zaorn Mode | Serall Mode

Previsw Mods
o5 090y € 4 [E-0- (MR & |0 [ [ FiteTon

Select Images

The background of
selected images
changes to blue.

3 Retumn to Main Menu

Favorite Folders | &)l Folders

Last Acquired Images
= All Tmages

=& shooting Dats U

% 2005_09_10

%] 2005_09_11

Favarite Folders

= [ My Pictures
) 2005_09_07
-3 2005_09_08
{23 2005_09_09
3 2005_09_10
{£3) 2005_09_11

IMG_0004.3PG IMG_0005.3PG IMG_0006.3PG IMG_0007.3PG

S

Add... Remove

Selected Items: 3 _l

3 Click [2. Printer and Layout Settings] and adjust the categories as you feel

necessary.

P Prinier Preview v =
Name
p Printer and Layout Settings RE" Rogm ‘ Tr@ge
e
1 Media Type:
Selects the printer ‘
and the paper size =
etc. 3 et ta bhain Men
@® Portrait O Landscape ]
Total 3 pages 1
—
- Page Layout Settings
H 1 [ Auto Trim
%ets prlntlng" to [ Barderless
borderless," etc.
Select additional information
10 print with your images:
[ Shooting Date
E'acet‘" Ch‘?d,: mark Sl cons [
ere _0 prin . Tet Color: [ [ Image /3 o .
shooting date/time < =
information W|th [ <pPrevious [ Print ] [ ] cancel ] |
images | selected Items: 3 |

Sets the number
of print copies

This button switches between images if
multiple images were selected.

4 Click [3. Print].

Printing will start.
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This chapter explained the ZoomBrowser EX basics.
Once you have mastered them, try the advanced techniques.
Using the Software on the Windows Platform — Advanced Techniques (p. 24).

e A PDF-format manual for ZoomBrowser EX is also available. It provides
further information about the program's features and procedures. See Using
the PDF Manuals (p. 2).




This chapter explains various ZoomBrowser EX features.

Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the
Using the Software on the Windows Platform — The Basics chapter.

The ZoomBrowser EX Windows

This section describes the principal ZoomBrowser EX windows: the Main Window, Viewer
Window and Properties Window.

This window is for displaying and organizing images downloaded to the computer.

Task Area (p. 25)

1 ZoomBrowser, EX - C: Documents and SettingsboodMy DocumentsiMy Picturest2005_09_0%

File Edit View Tools Inter

et Help

Function Buttons (p. 27)

— —
Yiew Tade Froperties Slide Show Search Delete 3 Rotate
i I |

Acquire & Camera Settings

(Gaon st Tocol biode | Freview Mode)
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Display Mode
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e

<

Add. ] {

Remave

(p. 26)

| Selected Items: O Ll

Folders Area (p. 25)

Browser Area (p. 25)

Switches between showing and hiding
the Task Area and Folders Area.

— Display Control
Panel (p. 27)
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TGSk Areu ZﬂEse cnts and SettingshboodMy DocumentsiMy Picturesi2005_09_09
e ZoomBrowser EX's tasks are arranged here like [ -
an indeX. @ Acquire & Camera Settings :DD;_D';;J Scrﬂ(\\-Mnda I P:wewéndvﬂo o
* Click a Task button to carry out the desired task. g
These features are described in ZoomBrowser @“"
EX Features (p. 30) @pi
Intermat
Folders Area S R—

e Use this area to select folders. The images in the selected folder display in the Browser Area.
If you select a network drive in advance with Windows Explorer, you can display network
folders, but you cannot add, change or delete those folders in the Browser Area.

e |f you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder

e |f [Favorite Folders] is displayed: click [Add] and select a folder.

e [f [All Folders] is displayed: select a folder and click [Add to Favorites].

¢ To delete a folder in the Favorite Folders area, select a folder and click the [Delete] button.

e Downloaded images also appear in the [Last Acquired Images] area at the top of the Folder
Area. You can check them in groups sorted by shooting date.

Using Cameras That Support My Category

e |n addition to classifying by Shooting Date, My Category also displays where the [Last
Acquired Images] message displays after the last image is downloaded.

e Also, in addition to the Star Rating it is possible to sort by My Category using the [Filter
Tool] function.

Browser Area

* The images in the folder selected in the Folders Area will display here.
The display style will vary according to your Display Mode selection.

e You can sort the image order in the Browser Area by file name, shooting date or other
characteristics by selecting [View] and [Sort by].

e The following icons will display around images according to their attributes.

E Images shot with the camera's Stitch Assist mode
m RAW images

Movies

. Images with sound memo attachments

Protected images

Images shot with the camera's AEB function

BORSEE

Rotated Images (In display only)
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Display Mode

e Selects the display style for the Browser Area.

Zoom Mode

Displays all the images in a folder as thumbnail
images. This mode is convenient for searching
for images since many can be displayed at
once.

If additional folders are nested within a

File Edit Wiew Tools Internet Help

1" ZoomBrowsen EX - C:\Documents and SettingsboodMy Documents\My Pictures

folder, their images are displayed as
thumbnails as well.

If you move the mouse cursor over a folder,
ta will display on the upper right. Clicking
here displays that folder zoomed in.

Scroll Mode

The images within the selected folder and
subfolders will display. If you set the display
folder depth (level) to [1] or greater, the
thumbnails of the images in the folder will also
display. You can change the folder depth in the
[Tools] menu under the [Preferences] option.

Preview Mode
This mode displays the image at a larger size as
well as the image information.

[ Taske 6] B view timage Propertiss @Shdeﬁhuw @Sear(h = f Delete
ﬁﬁ Acauite & Camera Settings Zaom Hede | Scrall Mode | Preview Mode | :
—_— e | | MyPices € > 4 R Maam| =
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L 5 - ,
Last Aoquired Images L T —
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{=-A shoating Dats —
0 i
e
&) 20050911 RS 1M1
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]
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Fie Edt View Took Inteerel Help
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»

Positioning the mouse pointer over a thumbnail causes the image to appear
at a higher magnification in a Mouse Over Window. You can turn off this
function by clicking the ® - [Show Information], and removing the check
mark from the [Show Mouse Over Windows] option.
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Display Control Panel

e This panel adjusts the display settings for the Browser Area.

Selection Menu Fit to Window Display Size
Click this to select/deselect all  Changesthe thumbnailsizeto Changes the size of the
images in the Browser Area. fit them into the window. thumbnail in the Browser Area.

|_I

€ ) Iﬁ' 0 - E]Q EL {rr? :D: ..J_ | 4,% Filker Toal

Show/Hide Image Information Menu Filter Tool Menu
Select here to show/hide such image Displays only images that
information as the file name or correspond to the specific
shooting date or rating beneath the conditions.
thumbnail.

Select Button

Use this to select images
in Zoom mode.

Function Buttons
e These buttons are available for executing various functions.

View Image Button Slide Show Button Rotate Button
Displays the selected image Starts a slide show of the Rotates the selected
or movie in the Viewer selected images. image.

Window.

E Wiew Image Properties Slide Show @ Search ﬁ Delete @ Rotate

Properties Button Search Button Delete Button
Displays information about Searches for images Deletes selected
the selected image in the using such criteria asthe images or folders.
Properties Window. Star Rating,

modification date,
shooting date,
comments or keywords.
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Double-click an image in the Browser Area to display it in the Viewer Window.

Edit Menu
You can edit, eliminating red eyes,
adjusting colors and brightness,
cropping and inputting titles. You can

also use it to start up other programs —5h°°t|"9_ Synchronize Button
for editing. Information sunchroni "
Display Button ynchronizes the
Print Button Displays image d'srl’l?yl settings when
Prints the displayed image. shooting g‘_u T'p edlmages are
information. Isplayed.

ZoomBrowser, EX - D:\Docume 1ts and SettingsboodMy DocumentsiMy Picturesi2004_09_09MG_0001..JPG |z HE”Zl
File Edit Yiew Help

THQ Q0@ [ Be- E 8w OO =
1

Image Selector S ] 7 AT st = N_umlber of
Button Displays
Switches between Button
images. Dlsglal_a%s
multiple
Sets the image  — images at
display size to the once. This is
size in the Viewer handy for
Window. comparing
images.

Displays images in —

the Viewer
Window at their
actual size.
|
Zoom Star Rating
Changes the image Sets the Star Rating for an image.

zoom setting.
Full Screen Button
Displays the image in the full screen mode. Click the
image or press any key on the keyboard to restore the
normal display mode.

e |f a RAW image is displayed, the [Display Original Image] button displays
beneath it. Clicking this button displays the converted image in the Viewer
Window.

e With Windows Vista and Windows XP, when a movie file is displayed, the
B (Capture Still Frame) button will display beside the Star Ratings. Clicking
this button extracts still images from movies.
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Properties Window

The Properties Window displays when you select an image in the Browser Area and click the
Properties button. The Properties Window does not display in the Preview Mode.

Shows or hides

categorles. &1 Properties
: Modified: 8/1/2005
] FieSize: 471.7KB
Image Size: 1600 % 1200
[rata Type: ARG
Sound: ———— Plays a sound memo attached
(Vewinage.. ) [P to an image.
Path: CA\Documetts and Settingshws by Docurme
ey Protect
. EX L Prevents an image from being
File Name {IMG_0001 |

overwritten or deleted.

The flle name Star R ating:

can be changed. ey
AW

Star Rating R Comment Comment
Sets the rating Keywords: You can type a comment here.
fOr an image' Brightness Histogram:

— Keywords

L Sets the keywords used in
searches.

- Brightness Histogram

g et A graph of the highlights and
R . . - -
lem Name 0¥ MAUGETS, | &) shadows distribution in an
File Mame IMG_D001.JPG .
Camera Model Name  Canon 3500 Im ag €.
Shaooting Date/Time  5/9/2004 3:15:22 AM
. . Shooting Mode Auto =
Shooting Information Tv [Shulter Speed] 17250
H H Ay [Aperture Walue] 71
_Dlsplays qetalled Light b etering Center ‘weighted Awg.
information, such as the Digtal Zoom Mone
Image Size 1600x1 200
ShUtter Speed and Image Quality Fine
i Flash [u]ij
eXp(.)Sure Compensatlon ol T 2
Settlng. The camera model Active AF Paints [ Center ]
. - =
WI” deter.-mlr?e What < F'rewous Mest > L Image Selector Buttons
9
information is displayed.

Switches between images.
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ZLoomBrowser EX Features

This section briefly introduces the Task Area functions.

Camera User Guide to see if your model supports them.

|§| Some functions may not be available with certain camera models. Check your

Acquire & Camera Settings

Opens the Camera Control Window, which lets

i @ Acquire & Camera Settings
you perform the following operations. =

Connect to Camera
Connects to your camera and lets you perform the following operations.

eAcquire Images
Downloads images and sound files from the camera (p. 16).

*Print Images
Selects and prints the images in a camera. You can print numerous ways, using DPOF
settings, print all images, the Index Print option, One Photo per Page Print option, or by
selecting images before printing.

eSet to Camera
Sets camera settings, such as the My Camera settings (p. 39). It also uploads images from
the computer to the camera.

*Remote Shooting
Allows you to operate the camera shutter from the computer (p. 35).

Connect to EOS Camera
This can only be used with EOS series cameras. For details on this function, see the user guide
for your camera. (Windows Vista and Windows XP only)

Acquire Images from Memory Card
Download images and sound files from a memory card (p. 19).
You can also select images on the memory card and print them.

View & Classify —

View as a Slide Show § 0 Wiew & Classify
Starts a slide show of the images selected in the
Browser Area.

Rename Multiple Files
Changes the file names of the selected images in a single pass.

Classify into Folder
Classifies images and saves them into a specified folder.

Search

Performs image searches using criteria such as the Star Rating, modification date, shooting
date, comments or keywords. Star Ratings, comments and keywords can be set in the image
information column in the Preview Mode or in the Properties Window.




Edit
Edit Image ‘@ E dit ‘

Allows you to perform image editing, such as
cropping, image correction and red-eye
correction. You can also use it to start other image editing programs.

Stitch Photos
Merges multiple images and creates a single large panoramic image (p. 38).

Edit Movie
Edits movies or still images strung together. You can add text as titles, or background music,
and apply various effects (p. 34).

Process RAW Images
Converts RAW images into standard images. You can adjust the image brightness, contrast
and color balance among other attributes during conversion.

Export -
Export Still Images ‘ﬁ@ Export

Allows you to change the image size or type,
and export it as a new image.

Export Movies
Allows you to change the movie size or type, and export it as a new movie.

Extract frames from a movie
Extracts still images from movies over a specified interval and saves them as image files.
(Windows Vista and Windows XP only)

Export Shooting Properties
Allows you to select the necessary data from the shooting information and export it as a text
file.

Export as a Screen Saver
Exports the image as a screen saver file.

Export as a Wallpaper
Exports the image as a wallpaper file.

Backup to CD
Copies images to a CD-R/RW disk for backup.
(Windows Vista and Windows XP only)

The Backup to CD function can only be used on computers satisfying the

following requirements.

e A CD-R/RW drive is included as standard equipment

* The write to CD-R/RW Driver function operates correctly on the Windows
Vista and Windows XP platforms
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Print
One Photo per Page Print ‘@ Frint

Prints one image per page (p. 21).
You can print "photo" prints easily.

Index Print
Lines up small versions of the images in rows and prints.

Print Using Other Software
Select the software to use and then print.

Internet
Email Images

[nternet

o

Converts the selected images to the appropriate
size for transmission by e-mail. You can also use
it to automatically start an e-mail program after conversion.

e To return to the previous screen after selecting a task, click [Return to Main
Menu] at the bottom of the task screen.

e Various Help functions are available in ZoomBrowser EX. Click the [Help]
menu, [?] button or [Help] button to display topics about operational
procedures or the functions available.
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Replaying Movies

|§| QuickTime is required to play and edit movies on the Windows 2000 platform.

1 Doublelick a thumbnail image with a movie icon in ZoomBrowser EX’s Browser
Area.

The Viewer Window will open and play the movie.

ZoomBrowser, EX - C:\Documents and Settingsbooddhy Documents\My PicturesiMovies\MV1_2340. AV ‘ZHEHE|
File Edt View Help

€ > 8 a M S B son (15 [0 [ BB | Eonew

wE ot e | B | mvi_zse0.au

You can save the displayed |- |
scene as a still image by

clicking here.

You can control the

movie's playback and (CoTETE
sound volume.
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Editing Movies

You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects

to the movies.

platform.

|§| * QuickTime is required to play and edit movies on the Windows 2000

e Movies are saved as Motion JPEG AVI movies.

1 cick [Edit] in ZoomBrowser EX's Main Window, followed by [Edit Movie].

2 Click [1. Add Images] and select the
You can select multiple movies or stills.

image (movie or still) you wish to edit.

3 Follow the steps at the left of the window to edit the movie and save it.

Follow these steps
to proceed.

7 ToomBrowser [X - D:\Decuments and Settingsuoodbly Dacuments\mavie 2

Click this button for detailed
operational instructions.

Instructions —

Ta set the play time or 10tstion, select the srage and chck, the bulion.

| T ] [ vompen ]

C it

Click this button to
play the movie
being edited.

Storyboard Area
Displays thumbnails of the selected
images.

Links images in order from left to right.

— Transition Effects Box

Appears between adjacent images
and displays the symbols of the
transition effects linking images.
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Operating the Shutter Remotely (Remote
Shooting)

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

This function may not be available with certain camera models. Check your
Camera User Guide to see if your model supports it.

Preparing for Remote Shooting

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

* Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between camera models. Please
refer to the Camera User Guide.

e Perform the settings described in First Time Camera is Connected to a
Computer (p. 17) the first time you connect the camera to the
computer.

The Camera Control Window will display.

2 Open the lens cover or remove the lens cap on models equipped with them.
Proceed to the next step if your model does not have one.

CIICk the [RemOte ShOOting] tab §2 CameraWindow - Canon 300000006 |._|,_ ['5_<|

L

Click [Starts Remote Shooting]. | Acauire Images | Prit_ | Setto Caffera| Remote shosting

E Etarts Remote Shooting

5 sclect a destination for the captured images and click [OK].
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RemoteCapture Task Window

The RemoteCapture Task window has the following features.

Shows/Hides the

viewfinder or detailed

settings area.

You can add
comments to images
by placing a check
mark here and
typing text in the
boxes below.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button

while a connection to
the camera is open to

display the image
appearing in the
camera’s viewfinder.

Size and Resolution Selector

Selects the size and resolution at which images are captured.

Ll RemoteCapture Task
File(Fy Camera{Ch Shooting(s) HelpiH)

() Hide viewFinder
(©) Hide shooting details

= Add comments shown below

Field angleflasth

Focusing Poirt:

AF unlock

o X

Rotation Settings
Sets the rotation
parameters for
images after they are
captured.

Release Button
Releases the
shutter.

Slide this to zoom
the camera in or out.

Start/Stop Viewfinder
Button

Starts or stops the
viewfinder display.

Refresh Button
Resets the exposure,
focus and white
balance.

Set the basic camera settings here.

The settings available in the RemoteCapture Task window vary between
camera models.




E
Remote Shooting

Ensure that you turn off your computer’s standby mode before you begin
remote shooting. The device performance cannot be guaranteed if the
computer enters the standby mode.

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

If you intend to hold the camera vertically to photograph a subject, you can save the
image to the computer with the correct orientation if you set the rotation settings in
advance.

N) =i

to On, the image will automatically be rotated and appear in the correct
viewing orientation in the RemoteCapture Task window when holding
the camera vertically.

|§| If your camera is equipped with the Auto Rotate function and you set it

3 Click the [Release] button.

®You can release the shutter by pressing the camera’s shutter button or
the keyboard'’s space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

* You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.
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Merging Panoramic Images - PhotoStitch

You can create a wide panoramic image by merging images of a scene shot separately.
PhotoStitch automatically detects the overlapping areas of adjacent images and corrects for the
size and orientation. You can also manually specify the overlapping areas.

1 cick [Edit] in the ZoomBrowser EX's Main Window and click [Stitch Photos].
2 Click [1. Select Images] and select several images in the Browser Area.
3 Click [2. Open PhotoStitch]. Cpmstich

Fle Edt Vew Merge Mo

Instructions

STA_DS78.PG

STE_O579.9G STC_0580.9G STD_D581.0PG

o, o Jmergric 3

4 Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.

Images Shot in Stitch Assist Mode

It is easy to merge images if they are shot with the camera's Stitch Assist
mode because PhotoStitch can automatically detect the image order and
orientation. The series of images are saved together in a single folder
when they are downloaded from the camera.

Symbol displayed by images
shot in Stitch Assist mode.

e Some camera models may not support Stitch Assist mode.

e See the Camera User Guide for information about shooting in Stitch Assist mode.

¢ Images shot in Stitch Assist mode with a wide converter, teleconverter or close-up lens
cannot be merged accurately.
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Enjoy Customizing Your Camera with the My
Camera Settings

This function may not be available with certain camera models. Check your
Camera User Guide to see if your model supports it.

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. You can add your favorite images and sounds from your
computer to the My Camera settings. This topic explains how to upload the My Camera
settings saved onto your computer to the camera and vice versa.

To register the My Camera settings with the camera, ensure that you install
the software that came with the camera.

Displaying the My Camera Window

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

* Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between camera models. Please
refer to the Camera User Guide.

e Perform the settings described in First Time Camera is Connected to a
Computer (p. 17) the first time you connect the camera to the computer.

The Camera Control Window will display.

2 Click the [Set to Camera] tab.

. |.-’-‘n.cquirelmages ||Et_| Setto Camera | lemote shooting|
3 Click [Set My Cameral].
The My Camera window will display.
h@
I Set My Camera
i

B Confirms/changes camera settings

& |

¢ Uploads images to the camera

Dizplays thiz screen when the camera iz connected

Freferences. ..
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The My Camera Window Features

ZoomBrowser EX already contains several pre-recorded My Camera settings. You can check
these items with the My Camera window.

Tabs
Click here to switch between adjusting the settings individually or in themed sets.
- Play Button
My Camera .
—, - = Plays the audio from the
etup as a theme el individual . . -
TR settings file in the
compl‘Iter Data Type: camera.
Displays the list of [Stum e H mer
amera
settings files saved g?!?ﬁfﬁ%: = Displays the settings in
= e Eh
onto the computer. SELngtg‘%:ngéjgg the camera.
oA S T Delete Button
ETHDANCEZ21_SION.JPG ac|>>»> F 2 . .
Eégégﬁggﬁ]gémmwa EMMEEJ (,anitﬁ Deletes a Settlngs file
FONZISI00 JPG = —— <o from the camera.
FUN24_5IM JPG Sawe to PC ‘
GaKKIZ1_5I01.JPG ¥
BNz B efeco]
EOLE S e '
Play Button s ol Save to Camera Button
Plays the audio from KIKORI21 SI01.PG ) Saves a computer
the selected settings — L oo | settings file onto the
file et camera.
) Closs.
Delete Button - Save to PC Button
Deletes a Sett|ngs file from Saves a camera Settings

the computer.

The pre-recorded My Camera
settings in ZoomBrowser EX
cannot be deleted (Windows
Vista only).

file onto the computer.

Depending on the camera, the [Return to
factory default settings] button will display.
Clicking this button will return the My Camera
setting to the factory default setting.

Camera:

|

Fieturn o Factary defalt settingﬂ

N
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Saving the My Camera Settings to the Camera

e My Camera settings can be selected and saved in either of two ways to the
camera: individually or in theme sets.

*The “Animal” theme, for example, features an animal in the start-up image
and animal calls in each of the sound files. The names of the prepared files
for the various My Camera settings themes all begin with the same root
name. The start-up image and sound files in the "Animal" theme, for
example, all begin with "Animal~".

Do not detach the interface cable, turn the camera power off or do anything

0 else that could disconnect the camera from the computer while the My
Camera settings are being saved to the camera or the settings from the
camera are being saved to the computer.

T Sselect the [Setup as a theme] tab in the My Camera window.
To set the start-up image or sound individually, click the [Set individually] tab and select it.

Select the settings file you wish to save to the camera from the My Computer list.

Select the setting from the Camera list that you would like to change and click
[Save to Cameral].

This concludes the process of saving the My Camera settings to the camera.

The Camera list setting will change to the selected file. If a setting for this category has
previously been saved to the camera, it will be overwritten.

WN

Repeat steps 1-3 as required.
To use this data on the camera, change the start-up image and sound settings on the
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer

T Sselect the [Setup as a theme] tab in the My Camera window.
To set the start-up image or sound individually, click the [Set individually] tab and select it.

Select the settings files from the Camera list that you wish to save to the
computer.

Click [Save to PC].

Add a name to the settings file you are saving and click [OK].

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

Rt N
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Adding New Data to the My Camera Window

Create a new image or sound file and add it to the My Camera window.
e Adding Image and Sound Files After Creating Them

Adding Original Start-up Images and Sounds After Creating Them

You can effortlessly create start-up image and sound files using the "My Camera Maker"
program.

1 Click the [Edit] menu in the ZoomBrowser EX Main Window and select [Manage
My Camera].

The My Camera window will display.

2 Click the [Set individually] tab in the My Camera window, followed by the [Create
My Camera Data] button.

My Camera Maker will start.

My Camera

Set individually |

Select bty Camera Data type and zet individually .

Setup as a the

Diata Type:

Start-up Imageffor common cameras) ;I

tdp Camputer:

221 5101 .JPG Startup Sound
321_5IM.JPG —

ANIMALDZZ_SI01.JPG Shutter Sound
ANIMALDZ23_SI01.JPG

BaAR21_SI00 PG Operation 5 ound
BASEBALL21_SI01.JPG

CHIMPANZ1_SI01.JPG | Selftimer S ound

ETHDANCEZ21_SIOJPG
ETHTECHM21_SI0.IPG
FUM21_SIN PG

FUM2Z_SIN PG

FUM23_SIN PG B
FUM24_SI0 PG
GAREIZ1_SI0M.PG

Add File Button GAMEZ1_SI01.PG

. ] GAMEZ2_SI01.JPG
Adds images and sound files for use poMES ST EE
i i i i HORSERACZ1_SI0IPG
as settings files. Added files display R o
in the list. KABUKIYO21_SIO1JPG
KILORIZ1 S101.JPG b/

Canon

—
Add File.... Create by Camera datal
Connect to camera Button - Eecdet : Caonnect to camera |
Connects to the camera.
Close |

3 Follow the instructions at the top part
of the My Camera Maker window and
create image or sound files.

= My Camera Maker

Start-up Image Creating
Click [Open] and zelect a JFEG image.

Instructions

‘ 7. Startup Image

Open...



4 once you have saved the file, click € and close the My Camera Maker window.
You have now succeeded in adding the file as a settings file to the computer.

To connect to the camera, click GAME 21 5101 JPG
[Connect to Cameral]. GAME 22_5101.JPG

You can add the settings files you just GOLF21_SI01.JFG Canon

added to the computer to the camera using IYASHI21_SI01JPG
. . KABLUKINYO21_S101.PG
the same procedures as in Saving the My KIKORIZI SITIPG o)

Camera Settings to the Camera (p. 41). AddFie.. | Create My Camera data

GAMEZ3 SI01.PG

HORSERACZ1_SINLIPG

o | _vase | ((oommtiocmas )

Cloze

d

E

i

e Use settings like those below when creating an image file for the start-
up image using an image editing program other than "My Camera
Maker."

Compression Method : JPEG (Baseline JPEG)
Data Sampling :4:2:0 or 4:2:2
Pixels (w x h) : 320 x 240 pixels

eUse settings like those below when creating a sound file using a sound

recording program other than "My Camera Maker."

Compression Method : WAV (Monaural)

Quantifying Bits : 8 bit

Sampling Frequency : 11.025 kHz or 8.000 kHz
Use the following lengths as guidelines for the length of sound file that
can be saved to the camera.

Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains the basic procedures for installing the software. Read this material before
you connect the camera to the computer for the first time.

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

ltems to Prepare

e Your camera and computer
e Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

Close any programs that are running.

Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.

3 Double-click the [Canon Digital Camera Installer] icon

N) =i

&
&qz) in the CD-ROM window.

4 Click the Digital Camera Software
[Install] button. Canon DIGITAL CAMERA

Solution Disk

Digltal Camera Software

e

= =,
‘ Exit )

|
Installer Panel
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Select [Easy Installation] and click
[Next].

Selecting an Installation Type

Select an installation type and click [Mext].

SeleCt [CUStom |nSta||ation] to SeleCt s.Werecommend this option for users unfamiliar with the
programs individually for installation.

() Custom Installation

Lets you select the programs you want to install. We recommend this option for users
familiar with the installation.

ol
Click [Agree] if you agree to all of the R
terms Of the SOftwa re Ilcense Canon grants you a non-exclusive license to install the Software into a
single computer and use such installed Software on such single computer at

agreement. a time. .
With respect to the sound data and image data contained in the Software 4
and which are to be transferred to applicable Canon's digital camera b

Review the installation settings and Starting
CI ick [N eXt] . Installation will begin using the settings listed below. Click [Next] to start copying files.
Follow the on-screen instructions to

Macintosh HD:Applications:Canon Utilities

proceed with the installation.

Programs to be Installed:

ImageBrowser
When the installation is over, click [OK].
s “ﬁ Installation has finished.

Click [Exit] in the installer panel and
remove the disk from the CD-ROM drive.

This concludes the software installation.

See Uninstalling the Software (p. 72) to delete the software installed
with these procedures.

Continue by downloading images to the computer (p. 46).



This chapter explains the procedures for using ImageBrowser to download the camera's images
to the computer and print them.

Read this chapter after completing the preparations in the Using the Software on the
Macintosh Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different according to whether you are using a camera to computer connection (see below) or
a memory card reader (p. 48).

1 Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See the
Camera User Guide.

The Camera Control Window will appear.

If it does not open, click the [CameraWindow] icon in the Dock (the bar at the bottom of
the desktop). To set this window so it does not automatically open when you connect the
camera to the computer, remove the check mark from the [Start when a camera is
connected] in the [File] menu in the Camera Control window.



2 Download images.

Download the images using the camera or
the computer. By default, the downloaded
images are saved into the [Pictures] folder.

Camera Control Window

47

00606 KOO KHXHKHKHK KK

Set to Camera = Remote shooting J

[ Acquire Images | Print |

Downloads using camera

@B

o Press the camera's button

e

Downloads using computer

You can adjust the settings, such as the type
of image downloaded and the destination
folder, by clicking [Preferences].

Starts to download images

- Lets you select and download images
=

- Preferences... )

Using the Camera to Download Images (Direct Transfer Function)

5

settings and procedures.

¢ |[f the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear in the LCD monitor. In addition, the
Lhas (Print/Share) button will light if your camera is equipped with one.
e See the Camera User Guide for instructions regarding Direct Transfer

Set the Direct Transfer settings on the
camera and press the Chyas (Print/Share)
button or the FUNC./SET button.

Using the Computer to Download Images
Click [Starts to download images].

Ve

Direct Transfer
G ALl Images..

Hd9eS

[v=» DPOF Trans. Images.

[» Select & Transfer..
EJ Wallpaper..

060 POV OO0 0000004

[—Acqnift-hnugeﬂ Print | Setto Camera | Remote shooting )

Downloads using camera

@B

o Press the camera's button

e,

Download
|
e

using p

Starts to download images

Lets you select and download images

( Preferences... )
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¢ By default, all the images that have yet to be downloaded will download.

* To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

e Click [Lets you select and download images] to show the camera images
in a list, check the images before downloading and download only
selected images.

The downloaded images are saved into folders according to the shooting date.

At the same time, they will also appear grouped by date in the [Last Acquired
Images] at the top of the Explorer Panel.

ans8 Browser Win dow
Folder S List | TimeTunnel |
Last Acquired Images] ————————— o e e
[ q g
. - . - 5 Shooting Date - W, My 2,
Clicking the shooting date o0 0n 00 ; -5
displays the images last e " - "
downloaded. 2 o ;
o (¥ E!DDS 0z 0:1
Explorer Panel B

s | 20005 _019_09
J 20050910

T
& - A
[ 20050911
[ 2005_09_12 AL : S
[ 2005.11_02 - 4 5 i
[ 20060105 e
¥ 2006.03.03 IMG_0G01 PG IMG_00D2IPG IMG_0003.JPG IMG_00D4.JPG IMG_0005.JPG IMG_0DD6.JPG IMG_0007.JPG

b [ Phato Ubrary ||
Destination for the = | 7 W A ma
downloaded images [am ME Bl “ W\ 2 8
The downloaded symbol AT R R e
displays on downloaded
folders. Thumbnail

According to the default settings, the thumbnails
(tiny versions) of the downloaded images display in
the Browser Window when the downloading is
complete.

Next, print out the images (p. 50).

Memory Card Reader Connection

Insert the memory card into the reader.

Use a separately sold card adapter if required.

See the manual for the memory card reader for details on how to connect and use the
reader.

The Camera Control Window will appear.

If it does not open, click the [CameraWindow] icon in the Dock (the bar at the bottom of
the desktop). To set this window so it does not automatically open when you connect the
camera to the computer, remove the check mark from the [Start when a camera is
connected] in the [File] menu in the Camera Control window.
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2 Click [Starts to download images]. 000 CANON_DC

: Acquire | | Print | Setto Memory Card }—\

@ Starts to download images
N—

You can adjust the settings, such as the type
of image downloaded and the destination
folder, by clicking [Preferences].

Lets you select and download images

‘ £
- Preferences... )

|§| ¢ By the default settings, all images are downloaded to the [Pictures]
folder.

e To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

eClick [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.

e See Memory Card Folder Structure (p. 75) for information about
memory card folder structures and file names.

The downloaded images are saved into folders according to the shooting date.

At the same time, they will also appear grouped by date in the [Last Acquired Images] at
the top of the Explorer Panel.

Next, print out the images (p. 50).
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Printing Images

There are three ways in which images may be printed: One Photo per page Print, Index Print
and Layout Print. This section explains the One Photo per page Print method.

5

Movies cannot be printed, but you can print stills after they have been
extracted from movies and saved to files.

One Photo per page Print

This option prints one

You select multiple

images, it will print them on the correspondmg number of pages

T Sselectthe images to print.
Clicking on an image selects it and displays a blue frame around it. To select multiple
images, hold down the [shift] or [§§ ] (command) key while clicking on images.

ene _ Browser Window

Folder

~ [y Last Acquired Images

-

&l Canon Camera
[ Movies
- [# Pictures

Preview | List | TimeTunnel

 Basic Information
File Name IMG_0001 |
Modified: Sar, May 26, i
File Size 560 KB |
Image Size: 1600 1200

Data Type PG

Sound 0

4 Shooting Date
5 2006_03_09

Lack: -
y StarRating

[4 2005_02_03
[7 2005_09_07
[ 2005_09_08
[.§ 2005_09_09

[ 2005_09_10
[# 2005_09_11
[ 2005_09_12
[7 2005_11_02
[¥ 2006_01_05
[ 2006_09_09

IMG_00@1.JPG IMG_0002.JPG IMG_0003.JPG IMG_0004..PG IMG_0005.JPG IMG_0006.JPG IMG_0007.JPG

S [4 IPhoto Library |
= g g ] A A [ B B A blue frame
= . " 2 N 2 P displays around
il e e o A | selected images.
2 Click [Print] and select [One Photo per -

page Print]. r@

Internet

One Phc-tc- per page Pnnt

Inde =
Layout Print...

Selecting [Index Print] allows you to print the thumbnails and shooting
information in a chart.

Selecting [Layout Print] allows you to layout and print multiple images on
a single sheet of paper.
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3 Setthe categories as you feel necessary.

ene One Photo per page Print
Printer ——| Praview
. Name:
Selects a printer. Pmamommm—
Selects options such as the papersize Sew o
and orientation when you click Orientation: ~ Landscape
[Page Setup]. 0 e s oenie

printers.

Configures the auto trimming

Page Layout Settings |

function. B
Auto Trim
Select a-d):liliunall information to o 1_'_ e
Place a check mark here to print the e ~ = 2 S
shooting dates/times with the ——f Oshosting oxe : S
i madges. () Shooting Time -
g Text color: - RalfLeﬁ Rowat%gm Tr\m—:n’age
Sets the number of copies printed.

i

Click this button to switch between
images if you selected multiple
images.

4 cick [Print].
The Print window will now open.

5 After setting the number of copies, and other settings, click [Print].

6 After the printing finishes, click ® to close the window.

This chapter explained the ImageBrowser basics.

Once you have mastered them, try the advanced techniques.
Using the Software on the Macintosh Platform — Advanced Techniques (p. 52).

A PDF-format manual for ImageBrowser is also available. It provides further
information about the program's features and procedures. See Using the PDF
Manuals (p. 2).




This chapter explains various ImageBrowser features.
Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the
Using the Software on the Macintosh Platform — The Basics chapter.

The ImageBrowser Windows

This section describes the principal ImageBrowser windows: the Browser Window, Viewer
Window and File Information Window.

This window is for displaying and organizing images downloaded to the computer.

Browser Area (p. 53)

806

Display Mode (p. 54)

low

Folder

ew_List | TimeTunnel J

- Last Acquired Images I
= &4 Shooting Date
[ 2006_08_09

¢ Canon Camera
Movies
= [ Pictures
[ 2005_02_03
[7 2005_09_07
[ 2005_09_08
2005209 081
[ 2005_09_10 |
[# 2005_09_11
[# 2005_09_12
[# 2005_11_02
7 2006_01_05
7 2006_09_09 |
[ iPhoto Library

Favorite

File Name:
Modified:

File Size:

Imange Size

Data Type

Sound o)

Lock: D

Sat, May 26,
580 KB
1600 1200
PG

 Star Rating

(T

v Comment

Explorer Panel (p. 53)

‘ &b ) ] =

anon Camera Wiew Image SlideShow

Internet v Frint

w  Send to Trash

Display Control Panel (p. 55)

No. af |mg~| Selactedt: 1 / Totak 7 images

Control Panel (p.

55)
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Explorer Panel

e Use this area to select folders. The images in the selected folder display in the Browser Area.

e |f you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder
o [f [Favorite Folders] is displayed: click [Add] and select a folder.
o [f [All Folders] is displayed: select a folder and click [Add to Favorites].

e Downloaded images also appear in the [Last Acquired Images] area at the top of the Explorer
Panel. You can check them in groups sorted by shooting date.

Using Cameras That Support My Category

e |n addition to classifying by Shooting Date, My Category also displays at the top of the
area where the [Last Acquired Images] message displays after the last image is
downloaded.

¢ Also, in addition to the Star Rating it is possible to sort by My Category using the [Filter
Tool] function.

Browser Area

* The images in the folder selected in the Explorer Panel will display here.
The display style will vary according to your Display Mode selection.
* The following types of icon will display around images according to their attributes.

Chl Images shot with the camera's Stitch Assist mode
RAW images

‘- Movies

mﬂ Images with sound memo attachments

=]  Protected images

By Images shot with the camera's AEB function

@ Rotated Images (In display only)
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Display Mode

e Selects the display style for the Browser Area.

Preview
This mode displays the image at a larger size as
well as the image information.

List
Displays the images in the folder selected in the
Explorer Panel section in rows and columns.

TimeTunnel

Displays images in chronological order in a
simulated time tunnel. You can move along a
timeline from the past to the present using the
slider that appears at the window's right.

| Browser Window

(“Preview | List | TimeTunnel |

€

 Basic Information ™
File Name IMC_0001
Modified Sat, May 28,

File Size: 580 KB

Image Size 1600 1200
Data Type IPG
Sound

nnnnn

IMG_0001.JPG IMG_0002.JPG IMG_0003.JPG IMG_0004.JPG IMG_0005.JPG IMG_0006.JPG IMG_0007.JPG

Browser Window

L]

! Preview | List | TimeTunnel | e

IMG_0002.JPG IMG_0004.JPG

=

‘ IMG_0005.JPG IMG_0006.JPG IMG_0007.JPG

I 1
Browser Windaw ]
Freview  List | TimeTunnel | |

NISA 0 @ 80D




Display Control Panel

e This panel adjusts the display settings for the Browser Area.

Display Size Selection Menu
Changes the size of the thumbnail in Click this to select/deselect all
the Browser Area. images in the Browser Area.

View 4,? Filter Taal

q @‘ ‘ Selec;ing Images

Filter Tool Menu Hide Buttons —M8 —
Use the Star Rating option in the Show menu Left: Hides the Explorer Panel.
to limit the scope of images displayed. Middle: Hides the control panel.

Right: Hides the image
information in the Preview
display mode.

Control Panel
* The control panel contains buttons for executing various functions.

i = k- = 3

Canon Carnera Wiew Image SlideShow Internet - Frint - Send to Traszh

The functions displayed here are explained in the Control Panel Features section (p. 58).

55
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Double-click an image in the Browser Area to display it in the Viewer Window.

806 |4 IMG_0001.JPG

Zoom
Changes the
image zoom
setting.

EATAL

—_— Star Ratings
<« » ’ & S ) & = ~ 9 Menu
Back Neost Save Edit - Displays - Synchronize Full Screen Print Show Informationy Sets ‘the S‘tar
Display Size 1600 x 1200} Display - 36% i .
Rating for an
Image Selector Button Image.
Switches between .
images. Show Information Menu
Displays shooting
Save Button information.

Saves the edited image.

Print Button
Prints the displayed image.

Edit Menu
You can edit, eliminating red eyes,
adjusting colors and brightness, cropping
and inputting titles.

You can also use it to start up other
programs for editing.

Full Screen Button

Displays the image in the full screen
mode. (You can also double-click an
image to display it in full screen mode).
Click the image or press any key on the
keyboard to restore the normal display
mode.

Number of Displays Menu
Displays multiple images at
once. This is handy for

comparing images. Synchronize Button
Synchronizes the display

settings when multiple
images are displayed.

If a RAW image is displayed, the [Show Original Image] button displays
beneath it. Clicking this button displays the converted image in the Viewer
Window.

e If a movie file is displayed, the [Save as Still Image] button will display
beneath movie images. Click this button to extract a still image from the
movie.
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File Information Window

The File Information Window displays when you select an image in the Browser Area, click the

[File] menu and select [Get Info]. The File Information Window does not display in the Preview
display mode.

Star Rating
Sets the rating for an image.

. 800 File Information
Shows or hides ===k
. w Star Rfting m
categorles. m
w Comment
i Comment
You can type a comment
here.
Plays a sound ¥ Kemord
File Name: IMG_0001
memo attached Modified Mon, bay 16, 2005 10°58 Al € View/Modify Keywords... et Keyword
to an image. e g e Sets the keywords used in
T e searches.
Sound: ofi)
Lock: M
Lock it Brightness Hlstogram
Prevents an image v . U A graph of the highlights
from being e N I and shadows distribution
overwritten or T Vo ‘ In an image.
d I t d File Marme IFG 000
eleted. Erac oo v
7
(D ETTD) Dl o o Y :
Image Selector Buttons Shooting Information
Switches between images. Displays detailed information, such
as the shutter speed and exposure
compensation setting. The camera
model will determine what

] information is displayed.
File Name

You can change
file names.
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ImageBrowser Features

This section provides a brief introduction to ImageBrowser features.

Camera User Guide to see if your model supports them.

|:Eﬂ| Some functions may not be available with certain camera models. Check your

Control Panel Features

3 8 @ a & sl

Canon Carmetra Wiew Image SlideShow Internet - Print - Send to Trash

Canon Camera
Opens the Camera Control Window, which lets you perform the following operations.

Acquire Images
Downloads images and sound file from the camera/memory card (p. 46, 48).

Print

Selects and prints the images in a camera or memory card. You can print numerous ways:
print all images, print a contact sheet (index) of all images, print using DPOF settings, or by
selecting images before printing.

Set to Camera
Sets camera settings, such as the My Camera settings (p. 67). It also uploads images from the
computer to the camera.

Remote Shooting
Allows you to operate the camera shutter from the computer (p. 63).

View Image
Displays the selected image or movie in the Viewer Window.

SlideShow

Starts a slide show of the selected images. Click the [View] menu and select [Slide Show
Options] to set the slide show settings.

Internet

Create Images for Email
Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.
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Print

One Photo per page Print
Prints one image per page (p. 50).
You can print "photo" prints easily.

Index Print
Lines up small versions of the images in rows and prints.

Layout Print
Allows you to freely arrange multiple images on a single page and print. You can also insert
captions and titles.

Send to Trash

Sends the selected images or folders to the Trash.

Functions Selected from Menus

Search Images: [File] menu, [Search]
Searches for images based on such criteria as Star Ratings, dates, keywords or captions.

Export Images: [File] menu, [Export Images]

e Edit and Save: allows you to change the file type or size and export the file.

e Export Shooting Properties: allows you to export the shooting properties as a text file.
e Export as a Screensaver: Exports the image as a screen saver file.

e Export an Image as Wallpaper: Exports the image as a wallpaper file.

Organize Images: [File] menu, [Organize Image]

eSort Images: sorts images according to criteria such as the shooting date or Star Rating and
saves them into a specified folder.

eRename: changes the files names of multiple images in a single pass.

Convert RAW Images: [File] menu, [RAW image processing]

Converts RAW images. You can adjust the image brightness, contrast and color balance
among other attributes during conversion.

Merge Panoramas: [Edit] menu, [PhotoStitch]
Merges multiple images and creates a single large panoramic image (p. 66).

Edit Movies: [Edit] menu, [Movie Edit]

Edits movies or still images strung together. You can add titles or background music and apply
various effects (p. 62).

Extracting Stills from Movies: [Edit] menu, [Extract frames from a movie]
Extracts still images from movies over a specified interval and saves them as image files.
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Display Settings: [View] menu, [View Settings]

Hides or shows image information beneath the thumbnail, such as the file name or the
shooting date and time.

Sort Images: [View] menu, [Sort]

Arranges image order in the Browser Area according to criteria such as the filename, file
modification date, file size or shooting date.



Replaying Movies

1 Doublelick an image with a movie icon in ImageBrowser’s Browser Area.

The movie will appear in the Viewer

Window.

Movie icon

2 Click the T button.

You can control the

movie's playback and
sound volume.

8086

[l MVI_2340.AVI

( Save as Still image... 3
['Fit to window jl[ T E

. j Number of E“‘
Save

E

Edit w Displays Full Screen

v Synehronizs
320 x 240

Display -

You can save the displayed scene
as a still image by clicking here.

=

Fr

int

Show \nfvrma\lwnv\‘

157%

4

61
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Editing Movies

You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects
to the movies.

1 Sselect the image(s) to edit in ImageBrowser’s Browser Area (movies or stills).
You can select multiple movies or stills.

2 Click the [Edit] menu and select [Movie Edit].

3 Follow the steps displayed in the middle of the window to edit the movie and save
it.

— Follow these steps
to proceed.

‘@06 MovieEdit Task

Arrange images.

1. To arrange images, select the image and click on the [Move Left] or [Move Right] button.

2. Click the [Play] button to playthe arranged effects and check them

3. Click the [Effect] tab ta go 1o Effect Step y

Instructions

2.Effect 3.Audic 4. Save

FIeN & E e

Add Image Play Time Rotate Move Left Move Right

L. Arrange

— s

Play

S, @— Click this button
feduce for detailed

operational
instructions.
-~
- J
Play Time 0:05.1 l ]
— Click this button Storyboard Area Transition Effect Box
to play the movie Displays thumbnails of the Appears between adjacent
being edited. selected images. images and displays the
Links images in order from symbols of the transition

left to right. effects linking images.
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Operating the Shutter Remotely (Remote
Shooting)

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you

record them and for high volume photography without worrying about filling the camera’s
memory card.

This function may not be available with certain camera models. Check your
Camera User Guide to see if your model supports it.

Preparing for Remote Shooting

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

* Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between camera models. Please
refer to the Camera User Guide.

e |f the Camera Control Window does not automatically appear, click the
[CameraWindow] icon in the Dock (the bar at the bottom of the
desktop).

The Camera Control Window will display.

2 Open the lens cover or remove the lens cap on models equipped with them.
Proceed to the next step if your model does not have one.

3 Click the [Remote shooting] tab. 000 XOOOKKKKKIOOXNK
[ Acquire Images Print Set to Camer: I—Renmte—shrmtmg—i

Starts Remote Shooting

4 cick [Starts Remote Shooting].

5 select a destination for the captured images and click [Choose].
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RemoteCapture Task Window

The RemoteCapture Task window has the following features.

Shows/Hides the
viewfinder or
detailed settings
area.

Size and Resolution Selector
Selects the size and resolution at which
images are captured.

You can add
comments to images
by placing a check
mark here and
typing text in the
boxes below.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to
display the image
appearing in the
camera’s viewfinder.

8o RemoteCapture Task
v Hide ViewFinder . (AL [E0 ]
v Hide shooting details 'fj 0 pal

1 add comments shown below

Release

g

S

CE—

- —

—f Field anglefﬂas‘ Shooting settings

L5

Focusing Point: Flash:

" Manual selectio... | % ] [Oﬁ:

Macro: FlashQuality:

(off = &
|| AF-assist light:
| (on )

AF operation:

" AF unlock | :]

Rotation Settings
Sets the rotation
parameters for
images after they are
captured.

Release Button
Releases the
shutter.

Slide this to zoom
the camera in or out.

Start/Stop Viewfinder
Button

Starts or stops the
viewfinder display.

Refresh Button
Resets the exposure,
focus and white
balance.

Set the camera shooting settings here.

i

The settings available in the RemoteCapture Task window vary between
camera models.
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Remote Shooting

Ensure that you turn off your computer’s sleep mode before you begin remote
shooting. The device performance cannot be guaranteed if the computer
enters the sleep mode.

Click | " and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

If you intend to hold the camera vertically to photograph a subject, you can save the
image to the computer with the correct orientation if you set the rotation settings in
advance.

If your camera is equipped with the Auto Rotate function and you set it
to On, the image will automatically be rotated and appear in the correct
viewing orientation in the RemoteCapture Task window when holding
the cameras vertically.

3 Click the [Release] button.

=] ¢ You can also release the shutter by pressing the camera’s shutter button
or the keyboard'’s space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

* You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.
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Merging Panoramic Images - PhotoStitch

You can create a wide panoramic image by merging images of a scene shot separately.
PhotoStitch automatically detects the overlapping areas of adjacent images and corrects for the
size and orientation. You can also manually specify the overlapping areas.

1 Select a series of images in the ImageBrowser’s Browser Area.

2 Click the [Edit] menu and select ene —
[PhotoStitch].

Click [2. Merge] to merge these images.
For images shot as a 360-degree panorama, click [Arrange], select
[360 Degrees] and then click [2. Merge].

Merge Images Shot in Stitch Assist Mode ‘

Instructions —

STA_0578.JPG STB_0579.JPG STC_0580.JPG STD_0581.JPG

Mo. of Images: 3 2592 x 1944 True Color

3 Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.

Images Shot in Stitch Assist Mode

It is easy to merge images if they are shot with the camera's Stitch Assist
mode because PhotoStitch can automatically detect the image order and
orientation. The series of images are saved together in a single folder
when they are downloaded from the camera.

Symbol displayed by images
shot in Stitch Assist mode.

® Some camera models may not support Stitch Assist mode.

e See the Camera User Guide for information about shooting in Stitch Assist mode.

* Images shot in Stitch Assist mode with a wide converter, teleconverter or close-up lens
cannot be merged accurately.
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Enjoy Customizing Your Camera with the My
Camera Settings

This function may not be available with certain camera models. Check your
Camera User Guide to see if your model supports it.

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. You can add your favorite images and sounds from your
computer to the My Camera settings. This topic explains how to upload the My Camera
settings saved onto your computer to the camera and vice versa.

To register the My Camera settings with the camera, ensure that you install
the software that came with the camera.

Displaying the My Camera Window

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

* Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See the
Camera User Guide.

e |f the Camera Control Window does not automatically appear, click the
[CameraWindow] icon in the Dock (the bar at the bottom of the
desktop).

The Camera Control Window will display.

2 Click the [Set to Camera] tab. 000 XOOOOORXKXX

(
I Acquire Images Prir’ |~ Set to Camera | Remote shooting ]

]

ﬁ Set My Camera
=

Confirms/changes camera settings

&

ﬁ Uploads images to the camera

3 Click [Set My Cameral].
The My Camera window will display.
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The My Camera Window

ImageBrowser already contains several pre-recorded My Camera settings. You can check these
items with the My Camera window.

Type
Select the settings type.

Computer
Displays the list

—— Save to Camera
- Save to Computer

My Camera

Play Button

Plays the audio from
the settings file in the
camera.

)

of settings files

Type:

[ Theme KB

saved onto the

Computer

[Camera

Camera
Displays the settings
in the camera.

221
321

computer.

EAR21

ANIMALO22
AMIMALOZZ

BASEBALLZ1
CHIMPANZ1

2:221
[3:221

Delete...

Play

Send to Trash

Canon

Delete Button
Deletes a settings
file from the
camera.

Save To:l‘lac 05 10.3.x:Users:¢ng:Library:Preferences:ImageBrowserUserData:

MyCame

laFiles:

Play Button
Plays the audio from the
selected settings file.

Save to Camera

Send to Trash Button
Deletes a settings file
from the computer.

ciose )

Save to Camera Button
Click here to save the
settings onto the

default setting.

camera.
Depending on the camera, the [Return  mera
to factory default settings] button will T 121
display. Clicking this button will return
the My Camera setting to the factory e s

( Return to factory default settings )
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Saving the My Camera Settings to the Camera

e My Camera settings can be selected and saved in either of two ways to the
camera: individually or in theme sets.

*The “Animal” theme, for example, features an animal in the start-up image
and animal calls in each of the sound files. The names of the prepared files
for the various My Camera settings themes all begin with the same root
name. The start-up image and sound files in the "Animal" theme, for
example, all begin with “Animal~".

Do not detach the interface cable, turn the camera power off or do anything

0 else that could disconnect the camera from the computer while the My
Camera settings are being saved to the camera or the settings from the
camera are being saved to the computer.

Select the type of setting in the Type list box that you wish to save to the camera.
Select the setting from the Computer list that you would like to add.

Select the setting in the Camera list that you would like to change and click the
button.

The Camera list setting will change to the selected file. If a setting for this category has
previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.

WN =

4 Click the [Save to Camera] button.

This concludes the process of saving the My Camera settings to the camera.
To use this data on the camera, change the start-up image and sound settings on the
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer

Select the type© s rrom the Type list box.
Select the setting in the Camera list that you Wlsh to save to the computer.

Click the | - | button.

Input a file name to the selected setting and click the [OK] button.

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

N =2
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Adding New Data to the My Camera Window

Create a new image or sound file and add it to the My Camera window.
e Adding Image and Sound Files After Creating Them

Create an Original Start-up Image File and then Add It

Start by using an image editing program to create the image file that will become the start-up
image and save it to the computer.

1 Click the [File] menu in the ImageBrowser Main Window and select [Canon
Camera] and [My cameral.

The My Camera window will display.

2 sclect the [Start-up Image] in Type.

3 Click [Add].
BARZ1
BASEBALL21
CHIMPANZ1 [
ETHDANCE21 1 _:’_:___.__.—
Add Button Add. .. Send to Trash |
Adds Images and ( Play ) ( Connect to camera ) Canon
sound files for use as
settings files. Added ,Swave To:Mac_ OS. 10,3ux:Users:eng:1ibrary'_F-‘rEfErences:lmageBrowserUserData:
yCameraFiles:

files display in the list.

Save to Camera )

Connect to Camera Button
Connects to the camera.

4 sclect the file you created and click [Open].
This concludes the process for adding new data.

5 To connect to the camera, click [Connect to Camera].

You can add the settings files you just added to the computer to the camera using the
same procedures as in Saving the My Camera Settings to the Camera (p. 69).
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Add an Original Sound File

Change the file to a WAV sound file after you have copied the sound file to the computer. Then
proceed with the steps as described in Create an Original Start-up Image File and then Add It.

e Use settings like those below when creating an image file for the start-
up image with an image editing program.
Compression Method : JPEG (Baseline JPEG)
Data Sampling :4:2:0 or 4:2:2
Pixels (w x h) : 320 x 240 pixels
e Use settings like those below when creating a sound file with a sound
recording program.
Compression Method : WAV (Monaural)
Quantifying Bits : 8 bit
Sampling Frequency : 11.025 kHz or 8.000 kHz
Use the following lengths as guidelines for the length of sound file that
can be saved to the camera.

Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains how to uninstall the programs.
Read the Troubleshooting section in this chapter if you experience a problem using the
programs.

Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to delete the
programs from your computer or when reinstallation is required to fix corrupted files.

Uninstalling the Software (Windows)

This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program. You can
remove other programs with the same procedures.

T Click the Windows [Start] menu and By, o e '
select [All Programs] or [Programs], U | X
followed by [Canon Utilities], . [@ s
[ZoomBrowser EX] and [ZoomBrowser s |G
EX Uninstall]. B @

A [y
The uninstall utility will start and remove Sgreranenss
ZoomBrowser EX. - | —
@ Phatogase 3 &) Canon PhotoRecord
All Programs | "3-5 izCar

@| Log OFF ‘§| Turn




Uninstalling the USB Driver (Windows)

It is essential to note that you will not be able to download images if you

0 uninstall the USB driver.

Windows Vista, Windows XP
You do not need to uninstall the USB driver.

Windows 2000

Uninstall the USB Driver using the following procedures.

1 Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

For interface cable connection instructions, see the Camera User Guide.

2 Click the [Finish] button if the Camera Control Window displays.

3 Click the [Start] menu and select

[Settings], followed by [Control Panel].

4 Dboubleclick the [Scanners and
Cameras] icon.

% Windows Update

_E WinZip

_{Zj Set Pragram Access and Defaulks

[

i

e

—

[f 55| Programs L4

5

'% } Documents

£ E'!% Settings »|E3  Control Panel

E CH = Flutal o

= Search 4

:::: Printers

& Help @ Taskbar & Start Menu. ..

Run...

A RS

7 Shut Dawn, .
ElETEEL

E3 Control Panel 3

File Edit View Favorites Tools  Help

qmBack ~ = - ‘ Qsearch [ Folders @“ﬁ E X w | [z~

Address I@ Zantral Panel
(. iz %

L Accessibility  AddjRemove  Add/Remove  Administrative  Automatic
Control Panel Options Hardware Programs Tools Updates

— = &5
Use the settings in Control Panel to _TET K& % Q
=

personalize your computer,

Display Folder Options Fonts Gaming Internet
Select an item to view its description. Options Options
windows Update r g
Ex iy &
Windows 2000 Support = -
Mouse Metwork and  Phone and  Power Options  Printers
Dial-up Co...  Modem ...
-
=
'\9:
-
Scanners and eduled Sounds and Systemm Users and

Cameras Tasks Multimedia Passwords

73
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5 select your camera model name or 20
[Canon Camera] in the [Scanners and

Cameras Properties] dialog, and click
[Removel.

Devices I

sl anners or cameras are installed :

(i) Canon Camera

Add... Remowve
Troubleshioot | Toperties

If your camera model name does not appear here, see the Camera not
detected, Events dialog won‘t display or images will not download to the
computer (p. 77) of the Troubleshooting section.

6 Click the Windows [Start] menu and select [Programs], followed by [Canon
Utilities], [Camera TWAIN Driver x.x] and [Uninstall TWAIN Driver]. A version
number appears in place of the “x.x".

The uninstall process will start.

To connect the camera to the computer and download after this point, use the following
procedures.

1. Reinstall the driver.

2. Connect the camera to the computer with the interface cable.

Uninstalling the Software (Macintosh)

Uninstall the programs by dragging the application’s folder (the folder in which it was installed)
into the Trash, and then empty the Trash.

Please be careMccidentally delete any folders with downloaded
images that may be contained within the application folder.
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Memory Card Folder Structure

The images on a memory card are placed in subfloders of the [DCIM] folder labeled
[xxxCANON], where the “xxx" represents a number in the range 100 - 999.

— IMG_xxxx.JPG (JPEG images)
_ __| T — _MG_xxxx.JPG (JPEG images recorded in the
DCIM Adobe RGB color space)
xxxCANON L cRW_xxxx.CRW (RAW images)
—— _RW_xxxx.CRW (RAW images recorded in the
Adobe RGB color space)
CRW _xxxx.THM*
—— STx_xxxx.JPG** (Stitch Assist mode images)
—— MVI_xxxx.AVI (Movies)
— MVI_xxxx.THM*
—— SND_xxxx.WAYV (Sound annotation)

The folder that holds the settings files for
images in the DCIM folder.

CANONMSC

The folder created when DPOF settings are set.
It holds the DPOF settings files.

MISC
—| | SDR_xxxx.WAYV (Files recorded with Sound Recorder)
SNDR xxXCANON

e *Files with the THM extension are the thumbnail image files for the camera’s index replay
mode.

e The “xxxx" in file names represent four-digit numbers.

e **Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which
is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG],
[STC_0003.JPG]...

e All folders except the “xxxCANON" folders contain image settings files. Do not open or delete
them.
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Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

Does your computer satisfy the requirements listed in the System
Requirements section (p. 8)?

? Is the camera correctly connected to the computer?

See the Camera User Guide for the correct connection procedures. Also
check to ensure that you are using the correct cable and that it is securely
attached at both ends.

? Are the camera and computer in the correct modes to transfer data?

Some models require the camera to be set to the playback mode to
transfer data. See the Camera User Guide for details.

? Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery.
You are recommended to use a household power source (AC adapter) to
power the camera when it is connected to a computer.



Problems

Try the suggested solutions to the common problems listed below.

? USB driver installation not proceeding well (Windows 2000).

Uninstall the driver (p. 73) before reinstalling it with the procedures in Installing
the Software and USB Driver (p. 11).

Add New Hardware Wizard or New Hardware Found (Windows 2000)
Wizard displays when the camera is connected to the computer with an
interface cable (Windows).

Click [Cancel] to close the window. Temporarily disconnect the camera from the
computer. Next, read Start by Checking This on the previous page and resolve
the problem.

Cannot download images or shoot remotely. (For cameras connected to
the computer via an interface cable: only cameras supporting Hi-Speed
USB 2.0).

The problem may be resolved by lowering the transmission speed for data by
following the procedures below.

Solution:

Hold the MENU button on the camera down and press the Dyas (Print/Share)
button and FUNC./SET button simultaneously. In the displayed screen, select [B]
and press the FUNC./SET button.

Images won’‘t download into a TWAIN-compliant program (Camera and
computer connected via interface cable (Windows 2000)).

Click the [Finish] button in the Camera Control Window to close it.

Camera not detected, Events dialog won’t display or images will not
download to the computer (when camera is connected to the computer
via an interface cable (Windows)).

Cause 1:

The USB Driver may not be correctly installed (Windows 2000).

Solution:

Install the USB driver with the procedures in Installing the Software and USB
Driver (p. 11). Then connect the camera to the computer with the interface
cable and prepare it to transfer data. If the USB driver is already installed,
uninstall (p. 74) it first and then reinstall it.
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Cause 2:

The camera may have been recognized as another device under the

following circumstances (Windows only).

e The camera was connected to the computer before the USB driver was
installed.

e The [Scanners and Cameras] icon or the [Scanners and Cameras] folder cannot
be found in the [Control Panel] or the [Printers and Other Hardware] window.

e Your camera model name, [Canon Camera] or a camera icon does not display
in the [Scanners and Cameras Properties] dialog or the [Scanners and
Cameras] folder,

Solution:
Delete the device with the following procedures.

You must be authorized as a Computer System Administrator to delete
devices.

1. Display the [Device Manager] dialog.
Windows Vista: Click the [Start] menu, [Control Panel], [System and
Maintenance], [System], and Task list [Device Manager].
Windows XP: Click the [Start] menu, [Control Panel], [Performance and
Maintenance], [System], [Hardware] tab, and the [Device Manager] button.
Windows 2000: Click the [Start] menu, [Settings], [Control Panel], [System],
[Hardware] tab, and the [Device Manager] button.

2. Click the [#] symbol beside the [Other devices], [Portable Devices] and/or
[Imaging devices] category.
Your camera model name or [Canon Camera] will display in these categories
if it is being recognized as an “other” device.

-0« LIET
| aon vew ||« 5|8 m | 2] @ e =R |
o . e
Complkter

(-2 Disk. drives -0 Disk drives

(- Display adapters (B Display adapters

5 DYD/CD-ROM drives 5 DYD/CO-ROM drives

% Floppy disk contrallers --@ Floppy disk controllers

--Q Floppy disk drives A= Floppy disk drives

2 IDE ATA/ATAPIL controllers -2 IDE Al Limalten

#& Keyboards =3

[T Mice and other painting devices e Gt

Monitars @ f

-3 Metwg IMice and orri=r poinking devices

EC@ 3 i Maritars

i - Network adapters

M O B L - o Ports (COM & LPT)

(-4 5C51 and RAID controllers -- = 5C51 and RAID cortrollers

There are other potential reasons for the problem if the “Other
devices”, “Portable Devices” or “Imaging devices” categories do not
appear or your camera model name or [Canon Camera] does not appear.
Proceed to Step 5, and temporarily quit the procedures.

3. Select your camera model name or [Canon Camera], right-click and select
[Delete].




5.

. Click [OK] in the confirmation dialog.

Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.

Close [Device Manager] or [System Properties].

With Windows 2000, continue by deleting the setup information file.

|§| Step 6 and above are not required for Windows Vista and Windows XP.

6. Double-click the [My Computer] icon on the desktop, followed by the [C:]

drive, [WINNT] folder and [inf] folder.

If the [inf] Folder Is Not Visible in the [WINNT] Folder
Use the following procedures to show all files and folders.

Open the [WINNT] folder.

Click the [Tools] menu and select [Folder Options].

Click the [View] tab.

In the [Files and Folders] category in the Advanced Settings section, set [Hidden files
and folders] to [Show hidden files and folders]. Remove the check marks from [Hide
file extensions for known file types] if it is present.

5. Click [OK] to close the dialog.

~wnN —

This will make the hidden files and folders visible.

x|
General Wiew | Fils Types | Difine Files
TUDI$ - Folder i
3 i “ou can set all of your folders to the same view
b ap M etwiark Drive. .
a . Like Current Folder I Fieset All Folders
Dizconnect Metwork Dirive...
Wi Toe
Advanced settings:
. R | Files and Falders -
Folder O phions.... [ Display compressed files and folders with altemate color
[ Display the full path in the address bar
[ Display the full path in title bar
() Da nat show hidden files and fold=
cammended)
[ Launch falder windaws in a separate process -
R ngs
Show by D ts on the Desktop =l
Restore Defaults
oK Cancel Apply

7. Look for files for Canon digital cameras that start with [CAP*].

The “*" represents a number, such as 0 or 1.
[CAP*] files come in pairs of [CAP*.inf] and [CAP*.pnf] files, “*" represents
the same number (For example, [CAPO.inf] and [CAPO.pnf]).

19
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8. Double-click the [CAP*] files to check their contents.
Double-clicking a [CAP*.inf] file will open it in the Windows Notepad
program. Check all files, and look for [;****Canon Camera Driver Setup
File****] in the first line. Note down the names of these files.

Several sets of [CAP*] files may be present in the [inf] folder. Open up
each file to confirm that it is an [CAP*] file for Canon digital cameras
before you do anything with the file.

9. Delete the [CAP*] file set.
Delete the [CAP*.inf] and [CAP*.pnf] file for Canon digital cameras that you
noted down in Step 8.

The [inf] folder contains numerous files critical to the computer’s
operation. Be extremely careful to delete the correct files. If you delete
the wrong files, you may be unable to restart Windows.

10.Reinstall the driver with the procedures in Installing the Software and USB
Driver (p. 11).

Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration
setting to a lower setting.

1. Click the Windows [Start] menu, followed by [Control Panel].
With Windows 2000, click the [Start] menu and select [Settings], followed by
[Control Panel].

2. Display the [Hardware acceleration] setting window.

Windows Vista: Click [Appearance and Personalization], followed by [Adjust
screen Resolution], [Advanced Settings] button and [Troubleshoot] tab.

Windows XP: Click the [Appearance and Theme] icon, followed by the
[Display] icon, [Settings] tab, [Advanced] button and [Troubleshoot] tab.

Windows 2000: Click the [Display] icon, followed by the [Settings] tab,
[Advanced] button and [Troubleshoot] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].
4. Restart the computer if prompted.
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An error message "Insufficient free memory" displays when

using PhotoStitch

Please try one of the following methods.
e Close all other applications other than PhotoStitch.

e Reduce the size or number of images to combine.
e |n the [Save] tab, select [Adjust image...], then in “Saved Image Size” reduce the size.

If You Were Using ZoomBrowser EX Version 2 or 3

Take the following steps if you were using ZoomBrowser EX version 2 or 3 with Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 5 the titles and comments you
input in version 2/3.

1. Use Windows Explorer to open the [Program] folder within the folder in
which you installed ZoomBrowser EX 5.
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Program)

2. Double-click [dbconverter.exe] found in this folder to start this utility.
With Windows Vista, right-click the [dbconverter.exe] file and select [Run as
administrator] to proceed with authorization as a computer Administrator.

3. Select the database file you were using up to this point and click the [Start]
button.
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd)

This will display the titles and comments input in the earlier versions in the
comments section of ZoomBrowser EX 5.

If You Had Images in a Folder Below the Program Files Folder

Image files in the [Program Files] folder or a subfolder cannot be displayed in
ZoomBrowser EX 5 from that location. To display these files, first perform steps
1-3 above and then carry on with Step 4.

4. Use Windows Explorer to copy the folder and the images it contains from the
[Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser
EX\Library One to another location.)

The moved folder images can now be selected and displayed with
ZoomBrowser EX 5.
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Downloading Images without Installing the
Software

If you are running Windows Vista, Windows XP or Mac OS X (v10.3/v10.4), download images
by simply connecting the camera to a computer, without installing the software bundled on the
Canon Digital Camera Solution Disk.

However, please note that there are several limitations.

This function cannot be used on the Windows 2000 platform. You must install
the bundled software for downloading with this platform.

|§| If you use the bundled software, the following limitations do not apply.

e [t may take a few minutes, after connecting to the camera, until you can download images.

® The camera information (firmware version, etc.) may not display correctly. In this case, use the
software from the Canon Digital Camera Solution Disk.

e Sound files attached to still images as sound memos and sound files recorded with the Sound
Recorder function may not download depending on file size and software used.

* RAW images may not be downloadable with some software programs or operating systems.

e Movies may not download correctly if the file size or software program is incompatible.

® Images shot in the vertical orientation may be downloaded in the horizontal position.

e The protection setting for images protected in the camera may be lost when transferred to
the computer.

® There may be other problems with image downloads depending upon the operating system
in use, the file size or the software in use.
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